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Trademarks

AJA®, KONA®, Ki Pro®, KUMO®,   and XENA® and are registered trademarks of AJA Video, Inc, 
Io Express™, Io HD™, Io™, and Because It Matters™ are trademarks of AJA Video, Inc. Apple, 
the Apple logo, AppleShare, AppleTalk, FireWire and Macintosh are registered trademarks of 
Apple Computer, Inc. Final Cut Pro, QuickTime and the QuickTime Logo are trademarks of 
Apple Computer, Inc. TASCAM is a registered trademark of TEAC Corporation. 

All other trademarks are the property of their respective holders.

Notice

Copyright © 2012 AJA Video, Inc. All rights reserved. All information in this manual is subject 
to change without notice. No part of the document may be reproduced or transmitted in 
any form, or by any means, electronic or mechanical, including photocopying or recording, 
without the express written permission of AJA Inc.

FCC Emission Information

This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference in which case the user will be required to correct 
the interference at his own expense. Changes or modifications not expressly approved by 
AJA Video can effect emission compliance and could void the user’s authority to operate 
this equipment.

Contacting Support

To contact AJA Video for sales or support, use any of the following methods:

180 Litton Drive, Grass Valley, CA. 95945 USA

Telephone: 800.251.4224 or 530.271.3190 
Fax: 530.274.9442

Web: http://www.aja.com 
Support Email: support@aja.com  
Sales Email: sales@aja.com

When calling for support, first read the Chapter on Troubleshooting at the back of this 
manual. You can often save time and effort by looking there first for simple remedies and 
information on how to get support from AJA.
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Limited Warranty

AJA Video warrants that this product will be free from defects in materials and 
workmanship for a period of three years from the date of purchase. If a product proves 
to be defective during this warranty period, AJA Video, at its option, will either repair 
the defective product without charge for parts and labor, or will provide a replacement 
in exchange for the defective product.

In order to obtain service under this warranty, you the Customer, must notify AJA Video 
of the defect before the expiration of the warranty period and make suitable 
arrangements for the performance of service. The Customer shall be responsible for 
packaging and shipping the defective product to a designated service center 
nominated by AJA Video, with shipping charges prepaid. AJA Video shall pay for the 
return of the product to the Customer if the shipment is to a location within the 
country in which the AJA Video service center is located. Customer shall be responsible 
for paying all shipping charges, insurance, duties, taxes, and any other charges for 
products returned to any other locations.

This warranty shall not apply to any defect, failure or damage caused by improper use 
or improper or inadequate maintenance and care. AJA Video shall not be obligated to 
furnish service under this warranty a) to repair damage resulting from attempts by 
personnel other than AJA Video representatives to install, repair or service the product, 
b) to repair damage resulting from improper use or connection to incompatible 
equipment, c) to repair any damage or malfunction caused by the use of non-AJA Video 
parts or supplies, or d) to service a product that has been modified or integrated with 
other products when the effect of such a modification or integration increases the time 
or difficulty of servicing the product. 

THIS WARRANTY IS GIVEN BY AJA VIDEO IN LIEU OF ANY OTHER WARRANTIES, EXPRESS 
OR IMPLIED. AJA VIDEO AND ITS VENDORS DISCLAIM ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. AJA VIDEO’S 
RESPONSIBILITY TO REPAIR OR REPLACE DEFECTIVE PRODUCTS IS THE WHOLE AND 
EXCLUSIVE REMEDY PROVIDED TO THE CUSTOMER FOR ANY INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES IRRESPECTIVE OF WHETHER AJA VIDEO OR 
THE VENDOR HAS ADVANCE NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.
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Chapter 1: Adobe Plugins Installation 

1

Installation Overview

The installation of Adobe Plugins for Mac or PC is very simple. All of the steps of installation 
and are described in this chapter and are presented as follows:

1. Installation procedure for Windows
2. Installation procedure for Mac

Note:  In this manual, the term KONA Software is used generically and includes support for  
Io XT and Io Express.

Important:  This procedure assumes you have successfully installed the AJA Retail 
Software version 10.1 (or later) driver package that is a prerequisite for Adobe Plugins 
installation. Also, always go to your AJA Utilities to uninstall existing KONA software before 
installing a new version. This will prevent hardware/software conflicts. 

Note:  Before proceeding, ensure that your capture, editing, or compositing Application 
Software (Adobe CS 5.5) is installed as detailed in its user documentation. These 
applications should be installed and run at least once prior to installing AJA KONA 
software. The Adobe Plugins package adds required files to your Adobe application 
directories. See KONA downloads at:

Download the latest KONA software from the AJA website or, if that is not possible, use the 
CD-ROM supplied with your AJA system to install necessary software drivers and AJA’s Mac 
Control Panel or Machina Capture/Playback application (if desired). Software updates 
occasionally become available to AJA KONA owners on our website at:

http://www.aja.com/support/index.php

We recommend checking for both software updates and additional product information 
before installation and periodically thereafter.
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Installing Adobe Plugins Software   

The installation procedures for Windows and Mac are described below. You cannot use 
KONA with third-party applications until the AJA plugins software has been installed on the 
host workstation.

If you add KONA supported applications at a later date and have not previously installed the 
appropriate plugins, you must run the install program again selecting the appropriate 
application support software to be installed.

Windows Software 
Installation 
Procedure

Locate the AJA Adobe Plugins Software for Windows download (or CD ROM packaged with 
your system) and follow the procedure below to install the required software on the host 
system. This AJA software for PC is intended for Windows 7, 64-bit workstations. 

The KONA/Io Express Windows 5.5.2 Software is divided into the packages shown below. 
The AJA Retail Software package must be installed first. We recommend you install the AJA 
Machina Control application next, followed by your desired Application Software (Fusion 
and Adobe CS5.5 are shown here).

AJA Installer Packages for PC

Note:  Before installing KONA software, turn off any virus protection and security software 
that you have installed on your computer.

This section describes the AJA Adobe Software package installation.

Access the software packages (download or CD ROM) and double click on the AJA Adobe 
package. 

Install Wizard
The installation program will launch and extract the necessary Adobe plugins for 
installation on the desired hard drive.
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Install Wizard Welcome

When you see the Welcome page, click “Next” to view the AJA license agreement.

License Agreement

Read the KONA license agreement and check the Agreement box to accept. You will be 
asked to choose the type of installation you would like to perform.
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Installation Type

If you don’t have all the KONA supported products installed on your workstation, you may 
choose to perform a Custom installation (default) and select only the software necessary for 
your applications. Otherwise, use the “Typical” installation. The following screens depict the 
more elaborate Custom installation.

Custom Installation Menu 
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You may deselect an Item for installation by using the pulldown to make it unavailable. 

Custom Selections Pulldown Menu

Use the second level options choose the specific drivers and plugins you would like installed. 
Disabled selections are marked with a red X. Before clicking Next to install, you can verify your 
disk space availability by clicking the Disk Usage button.

Workstation Disk Usage Display

To return to the installation click OK. Click Next to begin the installation. screen.



6

Begin Plugin Installation

When the installer has completed copying the Adobe Plugin software to disk, a final screen 
will be displayed announcing that “Setup has finished installing AJA KONA on your computer.” 
Click on the Finish button after the installation is complete.
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Mac Software 
Installation 
Procedure

Locate the AJA Adobe Plugins Software download or the AJA CD ROM packaged with your system 
and follow the procedure below to install the required software on the host system. The Adobe 
Plugins package for Mac requires Snow Leopard or Lion OS for operation. 

The Installation Software is divided into the packages shown below. The specific AJA product 
software package (KONA or Io Express) must be installed first. (Included in this installation 
package is the AJA Control Panel.) Next, you will install the Adobe CS5.5 plugins.

AJA Installer Packages for Mac (KONA 3G and Adobe Plugins shown)

Note:  Before installing AJA software, turn off any virus protection and security software that you 
have installed on your computer.

This section describes the AJA Adobe Plugins Software package installation. 

Access the software packages (download or CD ROM) and double click on the AJA Adobe 
package. 

Install Wizard
The KONA installation program will launch and extract the necessary KONA drivers for installation 
on the desired hard drive.

Install Welcome

When you see the Welcome page, click “Next” to view the KONA license agreement.
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License Agreement

Read the KONA license agreement and check the Agreement box to accept. You will be asked 
to choose the type of installation you would like to perform.

Installation Type

If you don’t have all the AJA Adobe supported products installed on your workstation, you 
may choose to perform a Custom installation and select only the software necessary for your 
applications. 
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Custom Installation After Effects Warning

Note:  Because of the Mac architecture of QuickTime components, AJA does not install Adobe 
After Effects plugins by default. We recommend that you install the After Effects plugins 
only for use with Io Express and then you must go to the After Effects Preferences, and 
under Video Preview, select “Computer Monitor Only” rather than “AJA” for the Output 
Device.

After Effects Preferences, Video Preview Settings

Because Io Express does not support colorspace conversion, it relies on the AJA Adobe After 
Effects Plugins to provide software-based conversion necessary for output. All currently 
supported KONA cards and IoXT, on the other hand, employ hardware colorspace conversion 
and do not rely on the slower software-based method. Therefore, the KONA cards and Io XT do 
not need the After Effects plugins installed. 

Note:  When using the AJA After Effects plugin with Io Express, software conversion 
requirements do not allow realtime RAM Preview.
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Installation Location Option

After setting up your installation content you can click “Change Install Location” if you prefer 
to override your system defaults. Click Install to begin installation.

Begin Plugin Installation
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When the installation is completed, a final screen will be displayed announcing that “The 
installation was successful.” Click on the Close and begin using your Adobe applications. 

 

Restart Screen

If you did not install all available plugins and you later add Adobe applications, you may repeat 
this installation procedure to install the required plugins. Remember to install and run the 
applications once before installing AJA software.

Re-Installation & 
Repair

If you have problems running your newly installed pluggins or need to re-install for added 
applications, you can relaunch and run the install package. 

Note:  Note: Always uninstall old KONA/Io Express software before installing a new version.
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Chapter 2: Using Adobe CS5.5 Applications 

2

Overview 

There are AJA plugins for both Mac and Windows versions of the Adobe Applications and 
functions are mostly the same. This chapter will describe the Windows menus and note 
exceptions for the Mac. 

Note:  Reference to “KONA software” also applies to Io Express and Io XT (functional 
exceptions will be noted by specific AJA device). AJA Adobe Software for Mac & PC 
operates on currently supported AJA KONA cards, Io Express, and Io XT at different 
functional levels. Some setup screens may use KONA, Io XT, or Io Express interchangeably 
when referring to your AJA hardware.

AJA Software for KONA is tightly integrated with Adobe CS5.5 Premiere Pro, Photoshop, and 
After Effects applications (not included with KONA). KONA allows a user to bring in supported 
Premiere Pro CS5.5 compressed formats and provides plug-ins and drivers that add 
functionality to the Premiere Pro application. 

After you install the KONA software on your workstation, all you need to do to begin using it is 
to become familiar with the AJA plugins and how Adobe CS5.5 applications access  
KONA options. 

The manual you are reading does not provide operational information for Adobe CS5.5 except 
as related to KONA operations. Please read the Adobe CS5.5 user documentation for Premiere 
Pro, Photoshop, and After Effects configuration and operation. 

The chapter you are reading addresses configuration and setups supported by KONA. Topics 
covered include:

• Adobe Premiere Pro 

• Realtime Performance

• Beginning a Project with KONA Presets

• KONA Capture Options

• KONA Playback Options

• Using Adobe Photoshop CS5.1

• Using After Effects CS5.5
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Adobe Premiere Pro Realtime Performance 

With KONA, Adobe Premiere Pro CS5.5 can perform the following functions in Realtime:

• KONA LHe Plus can capture uncompressed analog or digital SD and HD, component or 
composite, or S-Video to the supported file formats. 

• KONA LHi can capture uncompressed analog or digital SD and HD,HDMI, component 
or composite, or S-Video to the supported file formats. 

• KONA 3G can capture uncompressed digital SD or HD via SDI or Dual Link and 
uncompressed digital 2K via HSDL at 15 fps to the supported file formats.

• Playback of DPX, Cineon, Tiff, Targa, BMP, Quicktime, AVI, YUV, and HDV MPEG.

With Io Express or Io XT, Adobe Premiere Pro can perform the following functions in 
Realtime:

• Io Express can capture uncompressed analog or digital SD/HD-SDI or HDMI 1.3a to the 
supported file formats that are YUV. 

• Playback of Quicktime, AVI, YUV, HDV MPEG, XDCamHD, XDCamEX, DVCProHD, and 
AVCHD.

Note:  This happens automatically. Files of these types that match the resolution and frame 
rates of the projects will play in realtime as long as they are uncompressed and in one 
of the supported colorspaces. The exception is HDV, which of course is compressed. For 
HDV to playback RT it must be in a 1080 project and the frame rate or the file must 
match that of the project.

• Crop – happens automatically when an imported file is too large for the project size. 
Using Premiere Pro’s Motion Effects positioning, this realtime crop is keyframable 
(Timeline Option “Render RT files of different resolution” box must be unchecked). 
This also occurs when you use the Adobe Crop effects which can be found in the 
effects folders under Transform.

• Up/Down/Cross Convert the playback from the timeline. (KONA 3G, and LHi, and Io XT 
support up-, down- and cross-convert. LHe Plus and Io Express support HD to SD 
downconversion only.)
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Beginning a Project with AJA Presets 

Opening Adobe Premiere Pro CS5.5, you will select New Project from the Quick Start Screen and 
choose an AJA Capture Format from the pulldown menu, name the project, and click OK to 
access the New Sequence setup panel with presets or click the AJA Setup button to customize 
your workflow in the Capture Options panel “Premiere Pro Capture Options Panel” on page 19.

KONA Adobe Premiere Pro CS5.5 New Project panel

Note:  Using AJA Presets changes the monitoring of Closed Captions in Premiere Pro (See 
“Closed Caption Output” on page 25.).
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New Sequence Setup Panel

Using the New Sequence Setup panel, you can select from AJA Presets. The KONA Presets 
offer typical project settings.

The Description field summarizes the parameters for each preset including:

• Frame raster size • Timebase

• Frame rate • Pixel Aspect Ratio

• Field order • Audio sample rate

• Capture file format • Video Rendering format

• Sequence settings

You can adjust the preset Capture setting by going to Project>Project Settings>General to 
access the AJA Setup menu. See “Premiere Pro Capture Options Panel” on page 19..
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Options Set in 
Premiere Pro 
Preferences

Some settings that determine both capture and playback characteristics for KONA are accessed 
through Premiere Pro Preferences.

In Adobe Premiere Pro CS5.5 Preferences (under Edit>Preferences) you can set up global 
(default) settings for:

• Audio Hardware

• Audio Output mapping

• Device Control

Audio Hardware
Select “Premiere Pro WDM Sound” from the pull-down menu for your audio hardware. If you see 
“KONA ASIO” do not select it for use with KONA.

Audio Hardware Preferences

Device Control
Device Control Options are settings for the RS-422 machine control interface on KONA. Always 
use the AJA Serial Control and the KONA RS-422 port for KONA capture

Preferences>Device Control>Options
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Enter the desired value for:

Preroll – 0 to 15; the number of frames required to start the source machine before 
capture.
Timecode Offset –  -30 to +30; timecode adjustment (in frames) forward or back to 
compensate for discrepancies between the source’s burned-in timecode and that of 
the captured sequence.

Click on the Options button to pull up the AJA Device Control window.

Timecode Format – Use this pull-down to select the timecode base supported by your VTR.

• Base 24

• Base 25

• Base 25 NDF (50 frames per second)

• Base 30 DF (30 frames per second)

• Base 30 NDF (30 frames per second)

• Base 30 DF (60 frames per second)

• Base 30 NDF (60 frames per second)
The timecode format is used for both monitoring the RP-188 timecode embedded in the 
digital data stream and for selecting a timecode offset (if required) for the attached VTR 
(connected to KONA’s RS-422 port).

Timecode Source
Choose between a separate-channel Longitudinal Timecode (LTC) or Vertical Interval 
Timecode (VITC) transported in the video signal’s vertical interval or include both (LTC + VITC).
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Premiere Pro Capture Options Panel

Using the Capture Options panel, go to Window>Capture>Settings tab for Windows or use the  
Flydown menu for Mac>Capture Settings. To change settings for the selected Preset, click the 
Setup button. The following settings can be accessed:

• Capture Options – change Capture Format for the Adobe Premiere Pro CS5.5 project and 
access settings for KONA Capture. 

• Desktop display options

• File video/audio formatting options

AJA Capture Options panel (Mac version shown)
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Selection of Primary 
& Secondary 
Formats 

In KONA’s operation, the Primary Format is that which is written to disk. The Secondary Format 
is set to match the format of the input device (if the Primary Format is a conversion) or to 
match the format that is set for an output monitor if you’re monitoring a conversion and the 
Primary Format is the format on the input device.

Note:  The KONA Secondary Format nomenclature places (O) or (I) at the end of the signal 
format: (O) indicates the selected secondary format is for output only. (I) indicates the 
format selection is that of an input only.

The Secondary Format isn’t used if there are no conversions. In all of the applications 
supported by KONA, you can set these formats. In the Adobe applications (Premiere Pro, After 
Effects, and Photoshop), the KONA plug-ins provide similar ways of making these choices. In 
each application, though their interfaces may differ, these choices are virtually the same.

The Primary Format menu allows you to select the video format to be used in the current 
project. Analog output is always available and performs a conversion, if necessary, based on 
the Primary or Secondary Format.

Note:  No frame rate interpolation is applied for conversions from one frame rate to another.

Primary and Secondary Format Options Supported by KONA cards
Primary to Secondary conversion allows you to set down-, up-, and cross-conversion 
depending on the KONA model and formats supported.

For Formats supported by your AJA device, See “Appendix A: Performance Specifications” on 
page 37.

YUV<->RGB Range
This control mode should almost never be changed from its CGR default. This setting is only 
for highly-knowledgeable users that must define how color values will be mapped when 
doing the color space conversion—far less than 1% of all users should ever need to use it. Use 
this feature only for capturing YUV source into an RGB file, or to play an RGB file out to YUV. 
The CGR setting maps the typical YUV values to typical RGB values. For example, 8bit YUV 16 is 
mapped to 8 bit RGB 0, and YUV 235 to RGB 255. The ‘SMPTE’ setting for this control maps YUV 
into RGB using the exact YUV values. Therefore, 8 bit YUV 16 will map to RGB 16, and so forth. 
Only change this setting from its default if you are absolutely sure you know the benefits/
consequences. This feature is not the same as a broadcast safe limiter.

Video Input
Use the Video Input pull-down menu to select the appropriate signal type of your input. (The 
current selection is reported in the display of the pull-down menu.) 

Video Input always shows all the available input options based on your Primary and 
Secondary format configuration. KONA software looks at 1) what model you have, 2) Primary 
Format, and 3) Secondary Format (in that order) to determine what input options are 
appropriate. Video Input Options Supported by KONA cards include: 

• Single Link SDI• • Component Betacam NTSC-J

•  Composite NTSC• • Component SMPTE NTSC-J

•  S-Video NTSC• • Composite PAL

• Component Betacam NTSC• • S-Video PAL

• Component SMPTE NTSC• • Component Betacam PAL

• Composite NTSC-J• • Component SMPTE PAL

• S-Video NTSC-J• • Component XVGA (HD only)

• Dual Link HD (KONA 3G only)• • HSDL (KONA 3G only)
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Audio Input
Use the Audio Input pull-down menu to select the appropriate signal type for your input. (The 
current selection is reported in the Status Display.)

Audio Input Options Supported by KONA include:

• Embedded SDI 

• Digital AES/EBU – XLR (using either breakout cable or breakout box, except on KONA 3G)

• Digital AES/EBU – BNC (only applies if you are using a breakout box with BNC connectors 
for AES/EBU) 

• Analog (KONA 3G requires K3G-Box)

SDI Output 1 
When using KONA LHi cards, the SDI outputs will be Single Link only, if there is no Secondary 
Video Output Format selected. If you have a Secondary format selected, you can choose 
between Single Link SDI – Primary and Single Link SDI – Secondary as your output. KONA 3G 
also offers Dual Link output which uses both output connectors for a single A/B channeled 
output (SDI Output 2 automatically becomes Dual Link).

On KONA LHi, there is only one SDI output, but there is an HDMI output. You can independently 
configure the SDI output to HD or SD, and the HDMI input to SD or HD. The LHi has a hardware-
based downconverter, so you can output SD if desired, when playing back HD (or in E-to-E). 

Analog Output
Analog format choices in the Analog Output pull-down menu vary depending upon file format. 

• Composite + S-Video NTSC• • Composite PAL

• Composite + S-Video NTSC-J• • S-Video PAL

• Component Betacam NTSC• • Component Betacam PAL

• Component Betacam NTSC-J• • Component SMPTE PAL

• Component SMPTE• • Component RGB 

• Component XVGA (HD only)

Note:  When SD and HD formats are available as Primary and Secondary formats, you can 
choose between SD and HD raster for the Analog Output.

Audio Level
Choose between +6 dB (US) monitor level and +0 dB (EBU).

Timecode Input 
Select the type of timecode used by the source video machine—RS-422, Embedded SDI (RP188) 
or choose to input an External LTC timecode source input via the KONA RS-422 port.

Note:  SMPTE RP 188 defines a standard for the transmission of timecode and control code in 
the ancillary data space of a digital television data stream. Timecode information is 
transmitted in the ancillary data space as defined in ANSI/SMPTE 291M. Multiple codes can 
be transmitted within a single digital video data stream. Other time information, such as 
real time clock, DTTR tape timer information, and other user-defined information, may also 
be carried in the ancillary timecode packet instead of timecode. The actual information 
transmitted through the interface is identified by the coding of a distributed binary bit. 
Equipment manufacturers can use the meta data for different purposes.
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Desktop Display 
Options

Display To Desktop
Select one of four modes of desktop display:

• Off

• Display while idle only (this mode is suggested)

• Display during capture only 

• Display Always

Display to Desktop uses system resources and could affect performance. Choose Capture 
Speed, Width, and Height as appropriate for your system’s capabilities.

Display Capture Speed
• Full Speed – Every frame is displayed to desktop during playback

• Half Speed – Every other frame is displayed to desktop during playback

• Quarter Speed – One out of every four frames is displayed to the desktop

Half Speed and Quarter Speed will reduce the system load that the Display-To-Desktop is 
using to draw video to your computer. 

Desktop Capture Width and Height
These selections allow you to reduce the resolution of the desktop capture display. The 
captured file will be full-resolution. Only the displayed image is reduced to save processing 
resources during capture. The choices available are:

• Full Resolution • Eighth Resolution

• Half Resolution • Sixteenth Resolution

• Quarter Resolution

File Format Options The Premiere Pro Project Setting>Capture menu allows you to select one of the following AJA 
file formats from the Capture Format pulldown menu:

• AJA AVI Capture (Windows only) • AJA QuickTime Capture

• AJA Sequence Capture

Within the AVI and QuickTime formats, you can select one of the following subtypes by 
clicking on the Setup button to the right to bring up the AJA Capture Options menu. 

Note:  Capture file format options vary by KONA card model. The tables provided reflect a 
comprehensive list of supported formats (for KONA 3G). 

Under the File Options panel, select a video format subtype:

AVI files in the following Subtypes QuickTime files in the following Subtypes
8-Bit YUV 4:2:2 – ‘2vuy’
8-Bit YUV 4:2:2 – ‘2Vuy’
8-Bit YUV 4:2:2 – ‘uyvy’
10-Bit YUV 4:2:2 – ‘v210’
8-Bit RGB 4:4:4 – ‘bgr’
8-Bit RGB 4:4:4:4 – ‘bgra’
8-Bit RGB 4:4:4 – ‘bgr’ T2B
8-Bit RGB 4:4:4:4 – ‘bgra’ T2B
10-Bit Log RGB 4:4:4 – ‘R10g’
10-Bit RGB 4:4:4 – ‘R10k’
10-Bit RGB 4:4:4 – ‘r10k’

8-Bit YUV 4:2:2 – ‘2vuy’
8-Bit YUV 4:2:2 – ‘2Vuy’
10-Bit YUV 4:2:2 – ‘v210’
10-Bit YUV 4:2:2 – ‘V210’
8-Bit RGB 4:4:4 – ‘rgb’
8-Bit RGB 4:4:4 – ‘bgr’
8-Bit RGBA 4:4:4:4 – ‘argb’
8-Bit RGBA 4:4:4:4 – ‘rgba’
8-Bit RGBA 4:4:4:4 – ‘bgra’
10-Bit Log RGB 4:4:4 – ‘R10g’
10-Bit RGB 4:4:4 – ‘R10k’
10-Bit RGB 4:4:4 – ‘r10k’
16-Bit RGB 4:4:4 – ‘b48r’
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When you select AJA Sequence Capture, the File Options panel allows you to choose a 
Sequence Type:

• TGA Sequence • BMP Sequence

• DPX Sequence (LHi and KONA 3G only) • TIF Sequence

• Cineon (LHi and KONA 3G only) • YUV

Within these sequence types, KONA (model dependent) supports the following video formats:

Audio Formats
• 48 kHz 16-bit PCM Mono• • 48 kHz 16-bit PCM Stereo

• 48 kHz 24-bit PCM Mono• • 48 kHz 24-bit PCM Stereo

• 48 kHz 32-bit PCM Mono• • 48 kHz 32-bit PCM Stereo

Audio Track Count 
Select the number of audio tracks for this project, KONA supports up to eight (four stereo pairs) 
for KONA LHi or 16 for KONA 3G. Adobe Premiere Pro CS5.5 supports six channels.

DPX Sequences in the following Subtypes Cineon Sequences in the following Subtypes
10-Bit Log RGB 4:4:4 (BE) T2B
10-Bit RGB 4:4:4 (BE) T2B
10-Bit Log RGB 4:4:4 (BE) B2T
10-Bit RGB 4:4:4 (BE) B2T
10-Bit Log RGB 4:4:4 (LE) T2B
10-Bit RGB 4:4:4 (LE) T2B
10-Bit Log RGB 4:4:4 (LE) B2T
10-Bit RGB 4:4:4 (LE) B2T

10-Bit Log RGB 4:4:4 (BE)

TGA Sequences in the following Subtypes BMP Sequences in the following Subtypes
10-Bit Log RGB 4:4:4 (BE) T2B
10-Bit RGB 4:4:4 (BE) T2B
10-Bit Log RGB 4:4:4 (BE) B2T
10-Bit RGB 4:4:4 (BE) B2T
10-Bit Log RGB 4:4:4 (LE) T2B
10-Bit RGB 4:4:4 (LE) T2B
10-Bit Log RGB 4:4:4 (LE) B2T
10-Bit RGB 4:4:4 (LE) B2T

8-Bit RGB 4:4:4 B2T
8-Bit RGBA 4:4:4:4 B2T
8-Bit RGB 4:4:4 T2B
8-Bit RGBA 4:4:4:4 T2B

TIF Sequences in the following Subtypes YUV Sequences in the following Subtypes
8-Bit RGB 4:4:4(LE) B2T
8-Bit RGBA 4:4:4:4(LE) B2T
8-Bit RGB 4:4:4(LE) T2B
8-Bit RGBA 4:4:4:4(LE) T2B
8-Bit RGB 4:4:4(BE) B2T
8-Bit RGBA 4:4:4:4(BE) B2T
8-Bit RGB 4:4:4(BE) T2B
8-Bit RGBA 4:4:4:4(BE) T2B
16-Bit RGB 4:4:4(LE) B2T
16-Bit RGB 4:4:4(LE) T2B

8-Bit YUV 4:2:2
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Premiere Pro Playback Options 

To access AJA Playback settings, in Premiere Pro, highlight (select) the Sequence Panel. Then 
either use the fly-down menu in the top right corner of the Premiere Pro project window, or 
go to Sequence>Sequence Settings, and click on the Playback Settings button. 

Player Settings Panel

Note:  Primary Format, SDI and HDMI Outputs have the same functionality as described in   
the Sequence Capture Options panel. See “Premiere Pro Capture Options Panel” on 
page 19..

Audio Device
Select “AJA Audio” to output your project audio through the KONA. To complete audio setup 
refer to “Options Set in Premiere Pro Preferences” on page 17.

Analog Output
Analog Output Options Supported by KONA include:

• Composite + Y/C 

• Component (SMPTE/EBU N10) 

• Component (Beta)

Reference:
Select a source for the video reference signal:

• Free Run (none) • Reference Input (LTC/Ref connector) 

• SDI Input • HDMI Input
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Overlay Options
Enable and select overlay information to be included in the playback by checking the 
appropriate boxes. These overlay controls allow you to insert a graphic file supporting alpha 
channel transparency to apply an effect or insert a bug (logo) over the video content.

HDMI Output Options
HDMI video output offers these options:

• Protocol – choose Auto Detect, HDMI, or DVI

• Color Space – select Auto Detect or YCbCr 10bit (KONA does not support RGB)

• Audio Channels – choose 8 or 2 to be embedded

• Video Range – select SMPTE or Full Range

Advanced Options
Shared Output – the pulldown offers these options:

• Normal– choose for normal output connector routing

• Stereoscopic – select for use with Cineform First Light to control the 3D output. When 
selected and used with KONA 3G, the stereoscopic playback will be output on separate SDI 
outputs, left and right. (For playback output on a single SDI output, you can configure 
Cineform First Light to superimpose the left/right; see Cineform First Light documentation 
for details).

• Video + Key – choose this selection to output a video signal to one SDI output and a related 
Key signal to a second SDI output (useful for outputting to a video switcher for example).

Color Conversion – this menu lets you choose between AJA Hardware or Software conversion.

Quality – This setting can be used to adjust the visual quality and editing/playback 
performance of an AJA sequence in Premiere Pro. The quality setting is actually a setting that 
tells Premiere Pro which algorithms to use when rendering frames. This will apply to both 
scrubbing and playback. Lower quality settings tell Premiere to use faster algorithms for 
functions like deinterlacing, color conversion, transforms, and other effects with a slight penalty 
on visual quality. Higher quality settings use more complex algorithms, which may result in 
visually better results but at the cost of playback and scrubbing speed and performance.

Aggressive Cache
Under General options you can choose to enable Aggressive Cache. When this Option is 
enabled, AJA's plugins will read further ahead in the timeline during playback operations. The 
feature should be used to mitigate minor frame dropping issues. Particularly, this feature was 
created because some DSLR clips can take a very long time to open, and subsequently cause 
frames to drop when they are played back. Using this feature will consume more RAM, and may 
make scrubbing and stop/start commands slightly less responsive. The ideal way to use the 
feature is to leave it off at all times, and then to only turn it on for mastering/layoff to tape.

Closed Caption 
Output

When using Closed Captioning in Premiere Pro with an AJA Preset selected for your project 
(refer to your Adobe Premiere Pro help for Closed Caption settings), you will not see the 
captioning in your desktop Program Monitor display. The captioning will be included in the 
KONA playback output only. 
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Using Photoshop CS5.5

Adobe Photoshop CS5.5 (not included with KONA) accepts KONA plugins and drivers to 
closely integrate KONA functions into the application. After you install the KONA software on 
your workstation, all you need to do to begin using it is to become familiar with the Plugins 
and how Photoshop works with KONA. 

Important:  Mac plugins support only the AJA Preview Plugin (“Using the AJA 
Preview Plugin” on page 33).

With Photoshop open, you’ll go to the File pull-down menu and select Import>AJA Capture to 
set up your workflow, source device control, and other KONA options. Then access 
Export>AJA Preview Setup to configure the preview output to your monitor. Quick capture 
and simple send-to-preview functions are also available in these menus.

The manual you are reading does not provide operational information for Adobe Photoshop 
CS5.5. Please read the Photoshop user documentation provided with the application for 
information on configuration and operation. The chapter you are reading addresses 
configuration and setup unique to use of KONA with Adobe Photoshop CS5.5.

AJA Image Capture in Photoshop File>Import Menus (Windows only)

The KONA Photoshop plugin is a software application that is integrated into the Photoshop 
CS5.5 application and is accessed under the File menu. The Capture plugin provides you with 
standard tapedeck style play/record functions, status display, and configuration options. The 
Preview plugin allows you to adjust output formats and view your current project frame on a 
monitor connected to a KONA output before rendering to file.

In this section, you will read about the various pull-down options, hot-text entry fields, and 
play/record controls and how they interact.
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Note:  The specific options available to you are determined by the AJA capture device that is 
installed in your workstation and you are currently controlling. This section will describe all 
options for the Photoshop plugin when used with KONA. 

There are three functional areas in the Capture screen as indicated in the following illustration—
Status Display, Play/Record Controls, and Configuration Options. 

KONA Photoshop Capture Plugin Layout

The Status Display area is read-only information about configuration, current status, and 
performance.

The Play/Record Controls offer standard tapedeck controls and more. The hot-text fields 
beneath the video display are for writing and reading timing data. Capture mode will determine 
which fields are operational. 

Note:  Capture Play controls are RS422 machine controls for running a VTR tape deck with 
timecode data. 

• The Configuration Options section contains tabbed menu selections that provide:

• KONA Options – KONA workflow configuration options

• Image Options – Image formatting colorspace, frame, and crop information 
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If you don’t see the Configuration Options section, click on the Options triangle switch above 
the Status Display. In normal operation, you may decide to hide this section when it is not 
needed. 

File>Import>AJA Image Capture

Configuration 
Option Panels

The first Configuration Options tab selects the KONA Options panel for setting Board 
Activation mode and Capture format options. 

Activation Mode
A KONA plugin can be set for Automatic or Manual activation using the Activation Mode pull-
down menu. Automatic is the default setting and is recommended for normal operation. In 
this mode, you merely click between the open plugins to make one active. 

Note:  Only one plugin window can have control of the AJA capture device at a time. If the 
window you click on does not access the KONA (reporting Board: Active), either another 
window is still processing operations or it is set in Manual activation mode and must be 
disabled (check-box empty).

In Manual mode, you must check the Enable KONA box to activate the board control and un-
check it to release control. Upon startup of either Photoshop CS5.5 application, if the 
launched plugin window is in Manual mode, the window will NOT activate until the enable 
box is clicked again.
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The Preview plugin does not need activation since it grabs only one frame (the current working 
frame) at a time for output to the monitor. It grabs the data on a priority basis when it can. The 
rest of the time it is off.

Using the AJA 
Capture Plugin

First, activate the KONA from the Capture window and set up your workflow by defining Input 
and Output formats and timing options. To do this, click on the KONA Options tab. (KONA stores 
the workflow settings you make until they are next changed.) Next, access the Image Options 
tab to set colorspace and framing options and make Alpha Channel (for RGBA scanned-in 
images) and image crop settings if required. Finally, use the General Options menu to set 
timecode and other machine control options. 

KONA Options Menu

Capture Options
These options are the same as those for Premiere Pro except for Display to Desktop(See 
“Premiere Pro Capture Options Panel” on page 19.).

Display to Desktop allows you turn off the desktop capture display or “Display while idle only.” 
The latter is the suggested mode.
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Image Options 
Menu

After configuring KONA Options, select the Image Options tab. In the Image Options menu 
there are four configuration settings—Colorspace, Frame Scan, Set Alpha Channel, and Crop 
Image.

Photoshop Plugin Image Options Tab

Note:  You can enlarge the thumbnail capture image to full-screen by double-clicking on the 
image. To return, double-click again.

Colorspace – Choose between 8- and 16-bit color in either RGB 4:4:4, or RGBA 4:4:4:4 mode.

Frame Scan – Work with a Full Frame or capture Even or Odd fields only in single or double 
modes.

Set Alpha Channel – The Alpha channel image applies only to RGBA scanned-in images and 
then you can set it to 255 (default) which is zero transparency or 0 which is 100 percent 
transparency when the image is imported into Photoshop.

Crop Image – Use the hot text fields to enter value for pixels cropped from Top, Left, Right, 
and Bottom of the captured image. When you import (Accept) the image into Photoshop, it 
will be cropped to these specifications.
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General Options 
Menu

Under the General tab, you will find Device Control Options. These functions are for the  
RS-422 machine control interface on KONA. They support Print-to-Tape machine control.

. 

General Options Tab

Under the General tab, you will find Device Control Options. These functions are for the RS-422 
machine control interface on the KONA card. They support Print-to-Tape machine control.

Timecode Format – Use this pull-down to select the timecode base supported by your VTR.

• Base 24

• Base 25

• Base 25 (50 frames per second)

• Base 30 DF (drop-frame, 30 frames per second)

• Base 30 NDF (non-drop-frame, 30 frames per second)

• Base 30 DF (drop-frame, 60 frames per second)

• Base 30 NDF (non-drop-frame, 60 frames per second)

Timecode Source – Choose between a separate-channel Longitudinal Timecode (LTC) or 
Vertical Interval Timecode (VITC) transported in the video signal’s vertical interval or include 
both (LTC + VITC).

Click on the Hot Text items to enter a value for:

• Preroll – 0 to 15; the number of frames required to start the source machine before capture

• Timecode Offset –  -30 to +30; timecode adjustment (in frames) forward or back to 
compensate for discrepancies between the source’s burned-in timecode and that of the 
captured sequence. 

Status Display If you have more than one AJA capture device installed in your workstation, you can select 
another device to work with by using the Board pull-down menu at the top. If they are set for 
Auto Activation and are idle (not processing), you will immediately take control of the new 
Board (see Basic Plugin Operations and Configuration).

Photoshop Capture Window Status Display
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The Status Display section of the Photoshop Capture plugin, in the left column, reports the 
settings that you have selected for the KONA to use when you have control of it:

• Primary Format 

• Video Input type 

• Selected Colorspace

In the right column Capture Status reports the detected signal status of the KONA input:

Off Line – the capture plugin does not control the KONA
Idle – Ready, the plugin has control and the proper input signal is present
Video Input Not Detected – no input present

Play/Record 
Controls 

Standard tape deck icons provide hot buttons for the Play/Record RS-422 machine control of a 
source VTR. They are:

The slider on the bottom is a variable speed forward/reverse control. Positions from left to 
right are: (Reverse) 16x, 8x, 4x, 2x, 1/2, 1/4, Still, (Forward) 1/4, 1/2, 2x, 4x, 8x, and 16x. The red 
Record button is used to initiate a capture. 

Photoshop Capture Window Play/Record Controls

The pull-down menu on the right enables one of two capture modes:

• Capture Now – manual record/stop (“crash”) capture

• Capture In/Out – initiate a capture using timecode-based in or out settings

The selected mode will activate the appropriate hot text for that mode. Clicking the hot text 
brings up and entry field (hours:minutes:seconds:frames). The upper left display indicates the 
current timecode from the VTR. 

Capture In/Out – Enter a timecode Capture point by clicking on either the left field or right 
field of eight digits in the bracketed fields above the In/Out Duration field. Since Photoshop 
capture is a single-frame function, the In and Out settings will always be the same and the 
frame duration will always be one frame. 

Rewind (8x) Fast Forward (8x)

Reverse Play Reverse 1 frame

Still Stop

Play (1x) Forward 1 frame
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Note:  The in-point/out-point field values are inclusive. When both are set to the same value, 
the capture duration will be 1 frame.

To load the current VTR timecode setting in either field (in-point or out-point) click on the 
bracket ( { or } ) next to the field.

VTR TC – The VTR timecode field displays the current machine timecode and you can click on it 
to roll the VTR to another frame setting. The VTR must be online and in remote rather than local 
control mode (as reported in the VTR Status field.) 

Accept – When you have successfully captured the frame you wish to use in Photoshop, Click on 
Accept in the bottom right corner of the Play/Record pane. The KONA capture plugin will close 
and your frame will be opened in Photoshop for editing.

Using the AJA 
Preview Plugin

The Preview Plugin allows you to view on a monitor the current frame you are working on in 
Photoshop CS5.5. Go to File>Export>AJA Preview Setup to configure previews. When you have 
Preview Setup the way you want it, subsequent Previews are output by selecting AJA Preview 
(below AJA Preview Setup). 

Important:  Mac users will see AJA Preview only, not Preview Setup. Preview Setup 
for Mac is done using the AJA Control Panel.

AJA Export Plugins for Photoshop (Windows version shown)
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The “Board” pull-down menu at the top allows you to select any AJA capture device you have 
installed in your workstation (subject to Activation rules). A check box is provided to enable/
disable the Preview function.

AJA Preview Setup Menu for Photoshop 
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The Summary section reports current configuration settings. 

In Preview Options, you can vary the Primary and Secondary signal formats, Convert mode, 
YUV to RGB range for CGR or SMPTE levels (“YUV<->RGB Range” on page 20), SDI and Analog 
output type (as applicable), and select timing Reference mode—Free Run, External (genlock), or 
from the video Input signal.

In Color Options:

Choose one of the following output modes for 8-,16-, and 32-bit color projects:

• 8-bit YUV 4:2:2

• 10-bit YUV 4:2:2

• 8-bit RGBA 4:4:4:4

• 10-bit RGB 4:4:4

YUV Matrix Colorspace—choose from:

•  601SMPTE or 601 CGR (default selection for Standard Definition)

• 709 SMPTE or 709 CGR (default selection for HD)

Finally, for picture quality adjustment, you can output a Test Pattern selection using the pull-
down menu under Test Options. Click OK to output your Preview.

Using After Effects

After Effects CS5.5 
Plugin Overview

A KONA After Effects CS5.5 Preview plugin adds KONA functions to the After Effects CS5.5 
application. The KONA plugin screen is accessed under the Window pulldown menu. The 
Preview plugin allows you to view the current frame of your working timeline in various formats 
on a monitor connected to a KONA output.The Status Display area is read-only information 
about configuration, current status, and performance.

This section discusses settings common across plugin windows and how they interact. 

Activation Mode
A KONA plugin can be set for Automatic or Manual activation using the Activation Mode pull-
down menu. Automatic is the default setting and is recommended for normal operation. In this 
mode, you merely click between the open plugins to make one active. 

Note:  Only one plugin window can have control of the KONA at a time. If the window you click 
on does not access the card (reporting Board: Active), either another window is still 
processing operations or it is set in Manual activation mode and must be disabled (check 
box blanked).

In Manual mode, you must check the Enable KONA box to activate KONA control and un-check 
it to release control. Upon startup of the After Effects CS5.5 application, if the launched plugin 
window is in Manual mode, the window will NOT activate until the enable box is clicked again.

After Effects CS5.5 and Preview Note
Double clicking on a captured Project File in the project bin will sometimes open the file in an 
After Effects CS5.5 player which can be previewed. Some formats will result in the file opening in 
a third-party viewer (QuickTime for example)—but the file cannot be previewed in that viewer.
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Using the After Effects Preview Plugin 

The Preview Plugin allows you to view on a monitor the current frame you are working on in 
the timeline as it will appear at the KONA output. A summary area at the top of the Preview 
Window shows how the KONA is currently configured. If you wish to change it, you can use 
the Preview Options below. 

AJA Preview Plugin

In Preview Options, you can vary the Primary and Secondary signal formats, Convert mode, 
YUV to RGB range (“YUV<->RGB Range” on page 20), SDI and Analog output type (as 
applicable), and select timing Reference mode—Free Run, External (genlock), or from the 
video Input signal.

In Color Options:

Choose one of the following output modes for 8-,16-, and 32-bit color projects:

• 8-bit YUV 4:2:2

• 10-bit YUV 4:2:2

• 8-bit RGBA 4:4:4:4

• 10-bit RGB 4:4:4

YUV Matrix Colorspace—choose from:

•  601SMPTE or 601 CGR (default selection for Standard Definition)

• 709 SMPTE or 709 CGR (default selection for HD)

You can output a Test Pattern selection using the pull-down menu under Test Options. 
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Appendix A: Performance Specifications

A

KONA 3G Specifications

Video Formats

Up-Conversion
Hardware 10-bit
Aspect conversion modes:

Anamorphic – full-screen
Pillar box 4:3 – results in a 4:3 image in

center of screen with black sidebars
Zoom 14:9 – results in a 4:3 image zoomed 

slightly to fill a 14:9 image with black sidebars
Zoom Letterbox – zooms a 16:9 Letterbox source

to full-screen
Zoom Wide – results in a combination of zoom and

horizontal stretch to fill a 16:9 screen; this setting 
can introduce a small aspect ratio change

Down-Conversion
Hardware 10-bit 
Anamorphic – full-screen
Letterbox – 16:9 image with black top and bottom
Crop – image is cropped for full-screen image

Cross-Conversion
Hardware 10-bit
1080i to 720p
720p to 1080i

SD to SD Aspect Ratio Conversion
16:9 to 4:3 Letterbox
16:9 to 4:3 Horizontal Crop
4:3 to 16:9 Pillarbox
4:3 to 16:9 Vertical Crop

Standard Def HD 720 HD 1080 2K
525i 29.97 720p 23.976 1080i 25 2048 x 1080p 23.976
525i 29.97 (WIDE) 720p 24 1080i 29.97 2048 x 1080psf 23.976
625i 25 720p 25 1080i 30 2048 x 1080p 24
625i 25 (WIDE) 720p 29.97 1080p 23.976 2048 x 1080psf 24
480i 29.97 720p 30 1080psf 23.976 2048 x 1556p 14.98
480i 29.97 (WIDE) 720p 50 1080p 24 2048 x 1556p 15

720p 59.94 1080psf 24
720p 60 1080p 25

1080psf 25
1080p 29.97
1080psf 29.97
1080p 30
1080psf 30
1080p 50
1080p 59.94
1080p 60
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KONA LHi Specifications

Video Formats

Up-Conversion
Hardware 10-bit
Aspect conversion modes:

Anamorphic – full-screen
Pillar box 4:3 – results in a 4:3 image in

center of screen with black sidebars
Zoom 14:9 – results in a 4:3 image zoomed 

slightly to fill a 14:9 image with black sidebars
Zoom Letterbox – zooms a 16:9 Letterbox source

to full-screen
Zoom Wide – results in a combination of zoom and

horizontal stretch to fill a 16:9 screen; this setting 
can introduce a small aspect ratio change

Down-Conversion
Hardware 10-bit output, 16/24/32-bit internal processing
Anamorphic – full-screen
Letterbox – image is reduced with black top and bottom added

to image area with the aspect ratio preserved
Crop – image is cropped horizontally

Cross-Conversion
Hardware 10-bit
1080i to 720p, 720p to 1080i

SD to SD Aspect Ratio Conversion
16:9 to 4:3 Letterbox
16:9 to 4:3 Horizontal Crop
4:3 to 16:9 Pillarbox
4:3 to 16:9 Vertical Crop

Standard Def HD 720 HD 1080
525i 29.97 720p 23.976 1080i 25
625i 25 720p 24 1080i 29.97

720p 25 1080i 30
720p 29.97 1080p 23.976
720p 30 1080psf 23.976
720p 50 1080p 24
720p 59.94 1080psf 24
720p 60 1080p 25

1080psf 25
1080p 29.97
1080psf 29.97
1080p50, 59.94, 60
1080p 30
1080psf 30
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KONA LHe Plus Specifications

Formats

Down-Conversion

Hardware: 10-bit output, 24-bit internal processing
Anamorphic: full-screen
Letterbox: image is reduced with black top and bottom added to image 
       area with the aspect ratio preserved
Crop: image is cropped horizontally

Io Express Specifications

Formats

Down-Conversion
Hardware, 10-Bit output
Anamorphic: full-screen
Letterbox: image reduced with black top & bottom added to image area with the aspect ratio preserved
Crop: image is cropped to fit new screen size

Standard Def HD 720 HD 1080
525i 59.94 720p 50 1080i 50
625i 25 720p 59.94 1080i 59.94

720p 60 1080i 60
1080PsF 23.98
1080PsF 24
1080PsF 25
1080PsF 29.97
1080PsF 30
1080P 23.98
1080P 24
1080P 25
1080P 29.97
1080P 30

Standard Def HD 720 HD 1080
525i 29.97 720p 50 1080i 25
625i 25 720p 59.94 1080i 29.97

720p 60 1080i 30
1080PsF 23.98
1080PsF 24
1080P 23.98
1080P 24
1080P 25
1080P 29.97
1080P 30
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Io XT Specifications

Formats

Up-Conversion
Hardware 10-bit
Anamorphic: full-screen
Pillar box 4:3: results in a 4:3 image in center of screen with black
sidebars
Zoom 14:9: results in a 4:3 image zoomed slightly to fill a 14:9 image with
black side bars
Zoom Letterbox: results in image zoomed to fill full screen
Zoom Wide: results in a combination of zoom and horizontal stretch to fill
a 16:9 screen; this setting can introduce a small aspect ratio change

Down-Conversion
Hardware 10-bit
Anamorphic: full-screen
Letterbox: image is reduced with black top and bottom added to image
area with the aspect ratio preserved
Crop: image is cropped to fit new screen size

Cross-Conversion
Hardware 10-bit
1080i to 720P
720P to 1080i
720P to 1080PsF

SD to SD Aspect Ratio Conversion
Letterbox: This transforms SD anamorphic material to a letterboxed
image.
H Crop: Will produce a horizontally stretched effect on the image;
transforms anamorphic SD to full frame
SD Pillarbox: Will produce an image in the center of the screen with black
borders on the left and right sides and an anamorphized image in the
center
V Crop: Will transform SD letterbox material to an anamorphic image.

Standard Def HD 720 HD 1080
525i 29.97 720P 23.98 1080i 25
625i 25 720p 25 1080i 29.97

720P 50 1080i 30
720P 59.94 1080PsF 23.98
720P 60 1080PsF 24

1080PsF 25
1080PsF 29.97
1080PsF 30
1080p 23.98
1080P 24
1080P 25
1080P 29.97
1080P 30
1080P 50
1080P 59.94
1080P 60
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Index

A
accept Photoshop image 33
activation mode

After Effects 35
Photoshop 28

After Effects plugins 9
Aggressive Cache 25
alpha channel 30
Alpha Channel - Photoshop 30
analog output

Premiere Pro 21
audio level

Premiere Pro 21

C
capture in/out

Photoshop 32
capture window

Photoshop 29, 31
Closed Caption output 25
color space

Photoshop 30
color standards 35, 36
Colorspace - Photoshop 30
crop image

Photoshop 30

E
editing/playback performance 25

F
frame scan 30
Frame Scan - Photoshop 30

H
HDMI Output 25

I
image options

Photoshop 30
Installation Overview 1

K
KONA options menu

Photoshop 29

O
overlay 25

P
play/record controls

After Effects 35
Photoshop 32

plugin installation defaults 9
plugins

After Effects 35
preview options

After Effects 36
preview settings

After Effects 35
preview setup

Photoshop 33
primary/secondary formats 20

S
SDI outputs 1 & 2

Photoshop 30
set alpha channel 30
Shared Output 25

status display
After Effects 35
Photoshop 31

T
test pattern 35, 36
timecode source

Machina 18, 31

V
Video Input 37
video input options

Premiere Pro 20
VTR TC (timecode)

Photoshop 33
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